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Exploring Microsoft Office Excel 2016 Comprehensive (Poatsy/Grauer) 

Chapter 1  Introduction to Excel 

 

1) New workbooks typically contain how many worksheets? 
A) 0 
B) 1 
C) 2 
D) 3 
Answer:  B 
Diff: 1 
Objective:  1 Explore the Excel Window 
 
2) What is the small green square in the bottom right of a cell called? 
A) Sizing handle 
B) Fill handle 
C) Copy/Paste handle 
D) Move Cell handle 
Answer:  B 
Diff: 2 
Objective:  1 Explore the Excel Window 
 
3) What is not one of the tabs in Excel? 
A) Formulas 
B) Page Layout 
C) File 
D) Mailings 
Answer:  D 
Diff: 1 
Objective:  1 Explore the Excel Window 
 
4) Which of the following is not considered an Excel element? 
A) Formula Bar 
B) Name Box 
C) Active cell 
D) Print Preview 
Answer:  D 
Diff: 3 
Objective:  1 Explore the Excel Window 
 
5) Which of the following is not a valid keystroke for navigating around a worksheet? 
A) Ctrl + Home 
B) Ctrl + End 
C) Alt + Up arrow 
D) Page Down 
Answer:  C 
Diff: 2 
Objective:  1 Explore the Excel Window 
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6) Which of the following would not be considered text? 
A) Phone number (111.111.1111) 
B) Social Security number (111-11-1111) 
C) Part number (PT111) 
D) =2*2 
Answer:  D 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
7) What does pressing the Enter key while in a cell, do? 
A) The value is set, and the active cell remains the active cell 
B) The value is set, and the cell to the right becomes the active cell 
C) The value is set, and the cell below becomes the active cell 
D) The value is set, and the action is the same as pressing the Tab key 
Answer:  C 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
8) Which keyboard shortcut puts the user in cell edit mode? 
A) F2 
B) Shift F2 
C) F3 
D) Shift F3 
Answer:  A 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
9) Which of the following is not one of the recommendations when first designing a spreadsheet? 
A) Decide what your purpose is 
B) Decide what inputs you will need 
C) Estimate the amount of time required to complete the spreadsheet 
D) Decide what outputs you will need 
Answer:  C 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
10) How is text aligned by default? 
A) Left 
B) Center 
C) Right 
D) Decimal 
Answer:  A 
Diff: 1 
Objective:  2 Enter and Edit Cell Data 
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11) Which of the following is not a valid formula? 
A) =D3 
B) =2*2 
C) =sum(1,2,3,4,5) 
D) =#12/31/2014#-#12/31/2015# 
Answer:  D 
Diff: 3 
Objective:  3 Create Formulas 
 
12) What can the phrase "Please Excuse My Dear Aunt Sally" help you remember? 
A) How to do date calculations 
B) Order of operations 
C) Naming convention for cell ranges 
D) The various printing options available in Excel 
Answer:  B 
Diff: 3 
Objective:  3 Create Formulas 
 
13) In the formula, =1+(2-3)+5/6-6^2, what will Excel evaluate first? 
A) 5/6 
B) 1+ 
C) (2-3) 
D) 6^2 
Answer:  C 
Diff: 3 
Objective:  3 Create Formulas 
 
14) In the formula, =1+(2-3)+5/6-6^2, what will Excel evaluate second? 
A) 5/6 
B) 1+ 
C) (2-3) 
D) 6^2 
Answer:  D 
Diff: 3 
Objective:  3 Create Formulas 
 
15) Where is the Show Formulas command found? 
A) Formula Auditing group on the Formulas tab 
B) Formula Auditing group on the Data tab 
C) Formula Auditing group on the Review tab 
D) Formula Auditing group on the Developer tab 
Answer:  A 
Diff: 1 
Objective:  4 Display Cell Formulas 
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16) What should you do if there are columns you need, but do not want to display? 
A) Delete the columns you do not want to display then undo your action when finished. 
B) Move the columns you want to see so that they are together then move them back to their 
original locations with finished. 
C) Cut and paste the columns you do not want to display to another area of the worksheet. 
D) Hide the columns you do not want to display, then unhide them when finished. 
Answer:  D 
Diff: 2 
Objective:  5 Manage Columns and Rows 
 
17) What does it mean when you see ####### in a cell? 
A) Your formula is incorrect. 
B) At least one of the cell references in your formula is pointing to an empty cell. 
C) Your column is not wide enough. 
D) Your row is not tall enough. 
Answer:  C 
Diff: 2 
Objective:  5 Manage Columns and Rows 
 
18) One point is how big? 
A) 1/72 of an inch 
B) 1/36 of an inch 
C) The same as a pixel 
D) The same as one character 
Answer:  A 
Diff: 3 
Objective:  5 Manage Columns and Rows 
 
19) Which of the following is not a way to widen a column? 
A) Drag the line between the column headings to the desired size 
B) In the Page Layout tab, Scale to Fit group, select Automatic in the Width drop-down box 
C) Double-click the line between the column headings 
D) Right-click a column heading and select Column Width 
Answer:  B 
Diff: 3 
Objective:  5 Manage Columns and Rows 
 
20) A range is specified by its ________. 
A) top and bottom row and left and right column 
B) top row and leftmost column 
C) top right and bottom left cells 
D) top left and bottom right cells 
Answer:  D 
Diff: 2 
Objective:  6 Select, Move, Copy, and Paste Data 
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21) What is the best practice to switch the columns and rows in a range? 
A) Cut the range, then use the Paste Special option called Values 
B) Cut the range, then use the Paste Special option called Transpose 
C) Cut the range, then use the Paste Special option called Switch 
D) Cut the range, paste it into a blank area, then cut and paste each cell where you want it 
Answer:  B 
Diff: 3 
Objective:  6 Select, Move, Copy, and Paste Data 
 
22) Which is not a valid range? 
A) A1:A3, B1:B3 
B) A1:A9 
C) A1:F1 
D) A1:F9 
Answer:  A 
Diff: 2 
Objective:  6 Select, Move, Copy, and Paste Data 
 
23) Which Paste option would you choose if you wanted to flip the rows and columns? 
A) Transpose 
B) Rotate 
C) Flip 
D) Formulas 
Answer:  A 
Diff: 2 
Objective:  6 Select, Move, Copy, and Paste Data 
 
24) Which Paste option would you choose if you wanted only the computed values to be pasted, 
but with all formatting intact? 
A) Paste 
B) Values 
C) Values & Number Formatting 
D) Values & Source Formatting 
Answer:  D 
Diff: 3 
Objective:  6 Select, Move, Copy, and Paste Data 
 
25) What Paste option would you choose if you wanted to maintain the formatting of the copied 
cell, but not its contents? 
A) Formatting 
B) Keep Source Formatting 
C) Paste 
D) Keep Formating Only 
Answer:  A 
Diff: 3 
Objective:  6 Select, Move, Copy, and Paste Data 
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26) Where can you find more alignment options? 
A) Format Cells dialog box 
B) Format Alignment dialog box 
C) Format dialog box 
D) Format Rows and Columns dialog box 
Answer:  A 
Diff: 1 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
27) Which of the following is not included when you use a cell style? 
A) Font 
B) Cell protection 
C) Alignment 
D) Borders 
Answer:  B 
Diff: 2 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
28) What is the best practice for centering a title over multiple columns? 
A) Enter the title in the center column of the range 
B) Use the Merge Title feature 
C) Use the Merge and Center alignment 
D) Use the Combine and Center alignment 
Answer:  C 
Diff: 2 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
29) Which of the following is not a valid Cell Style? 
A) Heading 5 
B) Accent 3 
C) Input 
D) Calculation 
Answer:  A 
Diff: 3 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
30) The default number format is ________. 
A) Number 
B) Left aligned 
C) Two decimal places 
D) General 
Answer:  D 
Diff: 3 
Objective:  8 Apply Number Formats 
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31) Which of the following is not a valid number format? 
A) $1,000.00 
B) $       1,000.000 
C) (1,000.00) 
D) $       -1,000.00 
Answer:  D 
Diff: 3 
Objective:  8 Apply Number Formats 
 
32) What can you not do within the worksheet tabs shortcut menu? 
A) Format the worksheet 
B) Add color to the tab 
C) Insert a worksheet 
D) Delete a worksheet 
Answer:  A 
Diff: 2 
Objective:  9 Manage Worksheets 
 
33) Which of the following names of worksheet tabs would be best? 
A) Sheet 1 
B) Jan 
C) January Payroll Information 
D) JPAE 
Answer:  C 
Diff: 3 
Objective:  9 Manage Worksheets 
 
34) The best way to apply Page Setup options to multiple worksheets is to ________. 
A) group the worksheets 
B) use the Format Painter 
C) copy and Paste the formatting codes from one sheet to another 
D) use the Apply to Selected Sheets formatting command 
Answer:  A 
Diff: 3 
Objective:  10 Select Page Setup Options 
 
35) What is the best way to make sure your worksheet prints on only one page? 
A) Limit the amount of data you put on each worksheet 
B) Make the font sizes smaller 
C) Make the margins as small as possible 
D) Use the Fit to option 
Answer:  D 
Diff: 2 
Objective:  10 Select Page Setup Options 
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36) Besides the Page Setup dialog box, where else can you create headers or footers? 
A) Page Layout tab, Text group, Header & Footer 
B) Insert tab, Text group, Header & Footer 
C) Home tab, Text group, Header & Footer 
D) View tab, Text group, Header & Footer 
Answer:  B 
Diff: 2 
Objective:  10 Select Page Setup Options 
 
37) What would not be a typical item to have in a header or footer? 
A) The spreadsheet designer's name 
B) The filename or file path 
C) The file size 
D) The page number 
Answer:  C 
Diff: 2 
Objective:  10 Select Page Setup Options 
 
38) What can you not do from the Page Setup, Sheet tab? 
A) Set margins 
B) Set a print area 
C) Print gridlines 
D) Change the page order 
Answer:  A 
Diff: 2 
Objective:  10 Select Page Setup Options 
 
39) Where would you find the command to center the printout both horizontally and vertically on 
your paper? 
A) On the Page Setup, Alignment tab 
B) On the Page Setup, Sheet tab 
C) On the Page Setup, Margins tab 
D) On the Page Setup, Page tab 
Answer:  C 
Diff: 3 
Objective:  10 Select Page Setup Options 
 
40) What can you not do directly from the Backstage, Print screen view? 
A) Switch to formula view and print formulas 
B) Select which printer you want to use 
C) Select how much of the worksheet will be printed 
D) Set the page orientation 
Answer:  A 
Diff: 2 
Objective:  11 Preview and Print a Worksheet 
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41) A(n) ________ is a type of file that organizes data in rows and columns. 
Answer:  spreadsheet 
Diff: 1 
Objective:  1 Explore the Excel Window 

42) A(n) ________ is a collection of one or more related worksheets. 
Answer:  workbook, spreadsheet 
Diff: 1 
Objective:  1 Explore the Excel Window 
 
43) The intersection between a column and a row is called a(n) ________. 
Answer:  cell 
Diff: 1 
Objective:  1 Explore the Excel Window 
 
44) The current cell is also known as the ________ cell. 
Answer:  active 
Diff: 1 
Objective:  1 Explore the Excel Window 
 
45) The ________ feature can pull only part of a cell's value and place it into another cell. 
Answer:  Flash Fill, FlashFill 
Diff: 3 
Objective:  2 Enter and Edit Cell Data 
 
46) The ________ feature displays any values in the column that match what the user has typed 
so far. 
Answer:  AutoComplete, auto complete 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
47) The ________ area is where you store the variable you will be using in the worksheet. 
Answer:  input 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
48) The ________ area contains the formulas which are dependent on values found elsewhere in 
the sheet. 
Answer:  output 
Diff: 1 
Objective:  2 Enter and Edit Cell Data 
 
49) The ________ feature helps you complete an incremental series. 
Answer:  AutoFill, auto fill 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
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50) ________ can be used in calculations, whereas text cannot. 
Answer:  Values 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
51) Using ________ often decreases the amount of time it takes to enter cell references in 
formulas. 
Answer:  semi-selection, semi selection 
Diff: 3 
Objective:  3 Create Formulas 

52) You should use ________ in formulas whenever possible instead of static numbers. 
Answer:  cell references 
Diff: 2 
Objective:  3 Create Formulas 
 
53) A(n) ________ is a group of cells which have been selected at the same time. 
Answer:  range 
Diff: 1 
Objective:  6 Select, Move, Copy, and Paste Data 
 
54) A(n) ________ range contains several ranges. 
Answer:  nonadjacent 
Diff: 3 
Objective:  6 Select, Move, Copy, and Paste Data 
 
55) When you want to format your spreadsheet with a consistent look you should use the 
________ feature. 
Answer:  cell style 
Diff: 2 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
56) The ________ feature allows you to move some text to another line in the same row. 
Answer:  wrap text 
Diff: 2 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
57) You can ________ a cell's contents to the right or left to help it stand out from the row above 
or below. 
Answer:  indent 
Diff: 3 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
58) Cell ________ refers to how data are located within the boundaries of the cell. 
Answer:  alignment 
Diff: 2 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
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59) You can add ________ color to a cell or range of cells for emphasis. 
Answer:  fill 
Diff: 1 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
60) The ________ color is what is visible behind the value in a cell. 
Answer:  fill 
Diff: 2 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
61) A(n) ________ is a line you can put around a cell or range of cells for emphasis. 
Answer:  border 
Diff: 1 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 

62) Number ________ controls how a value appears in a cell. 
Answer:  formatting 
Diff: 2 
Objective:  8 Apply Number Formats 
 
63) When you do not need the data on a worksheet you should ________ it to make the file 
smaller. 
Answer:  delete 
Diff: 1 
Objective:  9 Manage Worksheets 
 
64) ________ a carefully formatted worksheet can save you a lot of time when you need that 
formatting on another sheet. 
Answer:  Copying 
Diff: 2 
Objective:  9 Manage Worksheets 
 
65) The ________ feature allows you to see how a document would print before you actually 
print it. 
Answer:  print preview 
Diff: 1 
Objective:  11 Preview and Print a Worksheet 
 
66) In Excel, columns are identified by numbers and rows by letters. 
Answer:  FALSE 
Diff: 1 
Objective:  1 Explore the Excel Window 
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67) Use the Find command to jump to a cell that is not currently visible. 
Answer:  FALSE 
Diff: 2 
Objective:  1 Explore the Excel Window 
 
68) The cell at row 4 and column B, would be identified as 4B. 
Answer:  FALSE 
Diff: 1 
Objective:  1 Explore the Excel Window 
 
69) Excel stores dates as numbers with 0 being 0 CE according to the Gregorian calendar. 
Answer:  FALSE 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
70) Adding color to cells is not considered a professional design strategy. 
Answer:  FALSE 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
71) It is always a good practice to test each formula you enter for accuracy. 
Answer:  TRUE 
Diff: 1 
Objective:  2 Enter and Edit Cell Data 

72) The contents of a cell can be seen in the naming box. 
Answer:  FALSE 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
73) For the fill handle to work you need to have two cells selected. 
Answer:  FALSE 
Diff: 2 
Objective:  2 Enter and Edit Cell Data 
 
74) Make sure to enter all cell reference in upper case when putting them in formulas. 
Answer:  FALSE 
Diff: 1 
Objective:  3 Create Formulas 
 
75) It is acceptable to use values in formulas when you know those values will never change. 
Answer:  TRUE 
Diff: 2 
Objective:  3 Create Formulas 
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76) The fill handle allows you to copy and paste formulas to adjacent cells. 
Answer:  TRUE 
Diff: 2 
Objective:  3 Create Formulas 
 
77) When you insert rows or columns all relative references are updated but not any absolute 
references. 
Answer:  FALSE 
Diff: 3 
Objective:  5 Manage Columns and Rows 
 
78) You can hide or delete multiple rows or columns by using the Ctrl or Shift key and then 
selecting the rows or columns you want to hide or delete. 
Answer:  TRUE 
Diff: 2 
Objective:  5 Manage Columns and Rows 
 
79) Displaying cell formulas can help find errors in formulas more easily. 
Answer:  TRUE 
Diff: 1 
Objective:  4 Display Cell Formulas 
 
80) If you do not need a row or column any more it is best to hide it instead of deleting it in case 
you change your mind. 
Answer:  FALSE 
Diff: 3 
Objective:  5 Manage Columns and Rows 

81) Right-clicking a column heading, then selecting Insert, will add a new column to the left of 
the current column. 
Answer:  TRUE 
Diff: 2 
Objective:  5 Manage Columns and Rows 
 
82) You cannot hide column A or row 1 because they cannot be unhidden. 
Answer:  FALSE 
Diff: 3 
Objective:  5 Manage Columns and Rows 
 
83) You can select a range by using the Name Box. 
Answer:  TRUE 
Diff: 2 
Objective:  6 Select, Move, Copy, and Paste Data 
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84) It is relatively easy to copy Excel cells into other Office programs. 
Answer:  TRUE 
Diff: 2 
Objective:  6 Select, Move, Copy, and Paste Data 
 
85) You can move a range by using the cut and paste commands. 
Answer:  TRUE 
Diff: 2 
Objective:  6 Select, Move, Copy, and Paste Data 
 
86) When you copy and paste a range the relative references do not change. 
Answer:  FALSE 
Diff: 2 
Objective:  6 Select, Move, Copy, and Paste Data 
 
87) When cells are merged, the merged cell's address becomes the address of the range. 
Answer:  FALSE 
Diff: 2 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
88) Bottom Align is the default vertical alignment. 
Answer:  TRUE 
Diff: 1 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
89) Using Alt + Enter is a text wrapping option. 
Answer:  TRUE 
Diff: 3 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
 
90) If you want to unmerge cells you click the Unmerge alignment option. 
Answer:  FALSE 
Diff: 2 
Objective:  7 Apply Cell Styles, Alignment, and Font Options 
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91) Match the following terms with their description: 
 
I. XFD 
II. Range 
III. Value 
IV. Semi-selection 
V. Text 
 
A. A measurable amount 
B. Also called pointing 
C. The last possible column in a worksheet 
D. A combination of letters not used in calculations 
E. A group of cells selected at the same time 
Answer:  C, E, A, B, D 
Diff: 1 
Objective:  Multiple Objectives 
 
92) Match the following terms with their description: 
 
I. Zoom control 
II. Workbook 
III. Worksheet 
IV. Sheet tab 
V. Cell 
 
A. Makes the text on the screen smaller or larger 
B. Contain labels, values and formulas 
C. The intersection of a column and a row 
D. Shows the name of the worksheet 
E. The same as a spreadsheet 
Answer:  A, E, B, D, C 
Diff: 1 
Objective:  Multiple Objectives 
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93) Match the following terms with their description: 
 
I. Name Box 
II. Order of operations 
III. Formula 
IV. Fill handle 
V. Pointing 
 
A. Always begins with an equals sign (=) 
B. Small green square used to perform various actions 
C. Displays the address of the active cell 
D. Also known as semi-selection 
E. PEMDAS 
Answer:  C, E, A, B, D 
Diff: 2 
Objective:  Multiple Objectives 

94) Match the following terms with their description: 
 
I. Paste Special, Add 
II. Transpose 
III. Flash Fill 
IV. Accounting number format 
V. Currency number format 
 
A. Sums the values of the pasted cells to the cells already there 
B. Puts the $ at the left margin of the cell 
C. Flips rows and columns when pasted 
D. Puts the $ next to the leftmost number 
E. Fills in data based on previous column's data 
Answer:  A, C, E, B, D 
Diff: 2 
Objective:  Multiple Objectives 
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95) Match the following terms with their description: 
 
I. AutoComplete 
II. Auto Fill 
III. Column heading 
IV. Row heading 
V. Enter icon 
 
A. The letter in the cell reference "F4" 
B. Helps complete a logical sequence 
C. The number in the cell reference "F4" 
D. Looks like a check mark next to the formula bar 
E. Matches the letters you type to another value in the column if the letters match 
Answer:  E, B, A, C, D 
Diff: 1 
Objective:  Multiple Objectives 
 
96) Match the following terms with their description: 
 
I. Normal view 
II. Page Layout view 
III. Page Break Preview 
IV. View controls 
V. Sheet tab navigation 
 
A. Displays data and page breaks 
B. Allows you to go to the first, previous, next, or last sheet in a workbook 
C. Does not display margins or page breaks 
D. Icons that let you change views 
E. Displays data and margins 
Answer:  C, E, A, D, B 
Diff: 2 
Objective:  Multiple Objectives 
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97) Match the following Ribbon tabs with their keyboard shortcuts: 
 
I. Data 
II. View 
III. Insert 
IV. Home 
V. File 
 
A. Alt + F 
B. Alt + N 
C. Alt + A 
D. Alt + W 
E. Alt + H 
Answer:  C, D, B, E, A 
Diff: 3 
Objective:  1 Explore the Excel Window 
 
98) Match the following Excel Elements with their description or action: 
 
I. Enter 
II. Cancel 
III. Status bar 
IV. Zoom control 
V. Formula bar 
 
A. Reverts back to previous data 
B. Shows the contents of the active cell 
C. Displays information about a command or operation as it is being performed 
D. Accepts the data 
E. Allows you to see more or less on the screen at one time 
Answer:  D, A, C, E, B 
Diff: 1 
Objective:  1 Explore the Excel Window 
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99) Match the following navigation shortcuts with their actions: 
 
I. Right arrow 
II. Page Down 
III. Home 
IV. End 
V. Ctrl + Home 
 
A. Moves active cell down one screen 
B. This does nothing by itself 
C. Moves active cell to column A, row 1 
D. Moves active cell to column A in that row 
E. Moves right one cell in the same row 
Answer:  E, A, D, B, C 
Diff: 1 
Objective:  1 Explore the Excel Window 

100) Match the following Paste options with their description: 
 
I. Values 
II. Picture 
III. Paste Link 
IV. Linked Picture 
V. Paste 
 
A. A reference to the cells, not the cell contents 
B. Unformatted results of formulas 
C. Cell contents and all formatting 
D. A non-editable copy of your data 
E. Changes if the content changes 
Answer:  B, D, A, E, C 
Diff: 2 
Objective:  6 Select, Move, Copy, and Paste Data 
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